
Fiery proServer User Guide



© 2018 Electronics For Imaging, Inc. The information in this publication is covered under Legal Notices for this
product.

45181510
11 May 2018 *45181510*



Contents

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Connecting and starting the Fiery proServer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Connecting the network and the printer to the Fiery proServer SE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Connecting the network and the printer to the Fiery proServer Premium . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Fiery proServer SE front panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Fiery proServer Premium front panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Fiery Quick Touch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Starting, shutting down, and rebooting the Fiery proServer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Changing the language of the Fiery proServer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Updating the software of the Fiery XF server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Start the Fiery XF server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Changing the language of the Fiery XF software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Backing up and restoring the Fiery proServer system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Fiery System Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Back up Fiery proServer system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Restore the Fiery proServer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Return Fiery proServer to its factory state . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Reinstalling Fiery proServer Premium system software from DVDs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Activating the Fiery XF software license . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Managing licenses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Anti-virus software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

Troubleshooting Fiery proServer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

Checking the Fiery proServer configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Checking interface connections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Troubleshooting corrupted system software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Downloading documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Fiery XF server online help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Fiery proServer User Guide

Contents

3



Fiery proServer User Guide

Contents

4



Introduction

This document describes how to connect and set up your Fiery proServer and keep it in good working condition
after installation.
The following topics are covered:

• Connecting the Fiery proServer

• Hardware components, including Fiery QuickTouch

• Starting, shutting down and rebooting the Fiery proServer

• Changing the language of Fiery proServer

• Updating the Fiery proServer software

• Starting the Fiery proServer software

• Backing up and restoring the Fiery proServer system

• Licensing the Fiery proServer software

• Using anti-virus software

• Troubleshooting

• Fiery proServer documentation and help

Note: The term Fiery proServer refers to both Fiery proServer Premium and Fiery proServer SE hardware. Different
procedures are provided for each when necessary.

Connecting and starting the Fiery proServer

All required cables and components are provided in the Fiery proServer shipping box.
Keep the following guidelines in mind when making connections:

• Be sure to use the appropriate power cable for your regional outlet type.

• By factory default, the upper Ethernet port is configured for DHCP, which means that it can dynamically request
IP addresses. Use the upper Ethernet port to connect the Fiery proServer to your company network.

• The lower Ethernet port is also configured for DHCP and can be used to connect to the inkjet printer, assuming
that both the Fiery proServer and inkjet printer are on the company network.

Note: The procedures for connecting the Fiery proServer Premium and Fiery proServer SE are different. See 
Connecting the network and the printer to the Fiery proServer Premium on page 6 and Connecting the network
and the printer to the Fiery proServer SE on page 6.
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Connecting the network and the printer to the Fiery proServer SE

The Fiery proServer SE has two network connectors on the back panel. The upper network connector is used to
connect the Fiery proServer SE to your network. The lower network connector is used to connect the Fiery
proServer SE to the printer.
• Use the graphic to help you in connecting the Fiery proServer SE to the network and the printer.

1 USB 2.0 ports

2 Monitor port

3 USB 2.0 ports

4 USB 3.0 ports

5 Power port

6 Network connection

7 Printer connection

8 Power switch

Connecting the network and the printer to the Fiery proServer Premium

The Fiery proServer Premium has two network connectors on the back panel. The upper network connector is used
to connect the Fiery proServer Premium to your network. The lower network connector is used to connect the Fiery
proServer Premium to the printer.
1 Insert the network cable into the upper Ethernet connector on the back panel of the Fiery proServer Premium.

2 Insert the printer cable into the lower Ethernet connector on the back panel of the Fiery proServer Premium.
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1 Power connector

2 Power switch

3 Type A USB2.0 ports

4 Type A USB3.0 ports

5 DVI port (monitor)

6 Network port

7 Command interface port (for straight-through Ethernet cable)

Fiery proServer SE front panel

The graphic displays the front and side panel of the Fiery proServer SE.
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1 Fiery Quick Touch

2 Type A USB 3.0 ports (x3)

3 Reset button

4 Power button
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Fiery proServer Premium front panel

Figure 1: Front and side panel of the Fiery proServer Premium

1 Fiery QuickTouch LCD 5 DVD drive

2 USB 3.0 ports (x3) 6 DVD eject button

3 Reset button (this is accessible only for a service technician)

4 Power button

Fiery Quick Touch

The Fiery Quick Touch LCD on the front of the Fiery proServer provides access to a number of functions.
You can do the following:

• Shut down, or reboot the Fiery proServer

• Restart the Fiery proServer

• Change the brightness setting of the LCD

By default, Fiery Quick Touch displays Idle after startup, which indicates that no jobs are currently being processed.
To display the Fiery Quick Touch main menu, press the ellipsis icon (three dots) at the top right of the display.
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Observe the following precautions when using Fiery Quick Touch:

• Avoid pressing the surface of the liquid crystal display (LCD).
Applying pressure to the LCD causes it to change color.

• Use a soft cloth moistened with lens cleaner to clean the surface of the LCD.
Other solvents, such as water, may damage the LCD.

• Handle the LCD with care.
If the LCD breaks and the liquid crystal inside leaks out, avoid contact. If you do come in contact with the liquid
crystal, immediately wash it off your skin with soap and water

Fiery Quick Touch status messages and commands

Fiery QuickTouch displays status messages and commands.

Status messages

Fiery QuickTouch displays the following status messages:

Starting up The Fiery proServer is starting.

Idle The Fiery XF server is started, but is not processed jobs.

Busy The Fiery XF server is processing jobs.

Fiery services are not responding. The Fiery XF server is not started.

Commands

Fiery QuickTouch has four commands. To display the commands, press the ellipsis icon (three dots) at the top right
of the display. You can select a command by pressing the corresponding icon on Fiery QuickTouch.

Shutdown system Shuts down Fiery proServer.

Reboot system Restarts Fiery proServer.

Restart system Restarts the Fiery XF. The connection to the Fiery XF software is automatically interrupted when you
select this command.

Brightness Enables you to adjust the brightness of the Fiery QuickTouch LCD. You can also use this command to
dim the display when it is inactive.

Starting, shutting down, and rebooting the Fiery proServer

This section describes how to start, shut down, and reboot the Fiery proServer when necessary.

Note: Always use the following procedures. Do not use the reset button on the side of the Fiery proServer to shut
down or reboot the system.
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Start the Fiery proServer

1 Set the power switch on the back of the Fiery proServer to the On (|) position.

2 Power on the Fiery proServer.
Press once and release the button to power on the system. The power supply automatically senses the correct
voltage.

3 At the Admin logon on the monitor, enter Fiery.1 in the password field, and then press Enter.
Type Fiery.1 exactly. The password is case-sensitive; for example, fiery.1 will not work.

4 Allow startup to proceed until the Fiery proServer desktop appears on the monitor, and Fiery QuickTouch
displays Idle.
The Fiery proServer takes approximately two minutes to start up. If you are starting Fiery proServer for the first
time, you are required to license the Fiery XF server as part of the installation procedure. For more information,
see Activating the Fiery XF software license on page 17 .
By default, the Windows taskbar is hidden.
The taskbar contains:

• Fiery Server Control, a separate application starts and stops the Fiery XF server, manages licenses, and
accesses updates.

• Fiery System Tools, a tool for changing the language of all Fiery proServer hardware and software
components, and for backing up and restoring the Fiery proServer system.

5 To display the Windows taskbar, do one of the following:

• To display the taskbar momentarily, move the pointer to the bottom of the screen.

• To display the taskbar at all times, right-click the taskbar and then click Settings. On the Taskbar tab, set Lock
the taskbar to on, and Automatically hide the taskbar in desktop mode to off.

6 To start the Fiery XF server, right-click Fiery Server Control and select Start Fiery Server.

7 To start Fiery Command WorkStation, right-click Fiery Server Control and select Start Fiery Command
WorkStation, or double-click the Fiery Command WorkStation icon on the desktop.

Shut down the Fiery proServer

1 Verify that the Fiery proServer is not receiving, processing, or printing any files.
If the system has just finished processing, wait at least five seconds after the system reaches Idle before you
proceed.

2 Exit the Fiery proServer software.
On the File menu, click Exit to close the client.

3 On the Fiery QuickTouch main menu, press Shutdown system.
Allow the system to shut down completely.
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Reboot the Fiery proServer

If a USB flash drive is attached to the Fiery proServer, remove it before rebooting. Otherwise, the Fiery proServer will
not reboot.

1 Verify that the Fiery proServer is not receiving, processing, or printing any files.
If the system has just finished processing, wait at least five seconds after the system reaches Idle before you
proceed.

2 Exit the Fiery proServer.
On the File menu, click Exit to close the client.

3 On the Fiery QuickTouch main menu, press Reboot system.
Wait for the system to reboot and the login window to appear on the monitor.

4 Enter the Admin password, and then press Enter.
Fiery.1 is the default Admin password and is case-sensitive. If your administrator has changed the password, and
the new password is lost, you must reset the Fiery proServer to its factory state. For more information, see <to
come.
When you have logged on, the Fiery proServer desktop appears.

Changing the language of the Fiery proServer

When you first start the Fiery proServer, after logging in, you select the language for the system. You can change the
system language at any time by using the procedure below.

Note: The language change takes up to 15 minutes to complete. When the language change is in progress, it cannot
be aborted.
The language change is applied to the operating system and keyboard, Fiery Server Control, and the Fiery XF server.

1 In the Windows taskbar, start Fiery System Tools.

2 Click Change system language, and select a language from the drop-down list box.
If you change the language, you need to restart the system.
The Fiery XF software also has its own language setting which overrides the language setting made for the Fiery
proServer. For more information, see Changing the language of the Fiery XF software on page 13.

Updating the software of the Fiery XF server

Check for software updates to make sure your software is up to date.
To update the software, the Fiery proServer must be connected to the Internet. It is essential to ensure that you have
the latest version of the software installed on your computer. A notification appears at the bottom of the Fiery XF
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server window when a free-of-charge update is available. The notification remains until you have updated your
system.

1 Exit the Fiery XF server and Command WorkStation.

2 Click the Fiery Server Control icon in the taskbar, and click Fiery Online Updater.
The Updater dialog box appears.

3 Click Next.
A dialog box with a list of currently available software updates appears. It indicates which update files are
available and also gives information about file size and version number.

4 Select the check boxes of the updates you want to install, and click Next.

5 Follow the on-screen instructions to download the updated files, and to complete installation.

6 Restart your computer, if prompted to do so.
For more information, see Fiery Command WorkStation Help.

Start the Fiery XF server

The Fiery XF server starts automatically whenever you start the Fiery proServer. If you exit the Fiery XF server for
any reason, you can restart it.
1 Right-click Fiery Server Control, and click Start Fiery Server.

2 Right-click Fiery Server Control and select Start Fiery Command WorkStation, or double-click the Fiery
Command WorkStation icon on the desktop.
In Command WorkStation, you can view information on the the status of your Software Maintenance & Support
Contract (SMSA) and other software licenses in Server Manager, accessed from the Server menu. In Server
Manager, click the Server icon, then select License & Contract.

Changing the language of the Fiery XF software

You can change the language of Fiery XF software in Command WorkStation Preferences.
The Fiery proServer comes installed with Fiery XF software, which includes Command WorkStation.

1 In Command WorkStation, click Edit > Preferences.

2 Click Region.

3 Select a language.

4 Click OK.

5 Restart Command WorkStation.
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Backing up and restoring the Fiery proServer system

A Fiery proServer system backup enables you to restore the Fiery proServer to an earlier state in case of a problem,
without having to return it to its factory settings.
You can use Fiery System Tools for backing up and restoring system software. If necessary, you can reinstall system
software from the system software DVDs.
It is recommended that you create a backup when you have set up the Fiery proServer system, and then backup
approximately every three months.

Fiery System Tools

Fiery System Tools provides tools to manage the Fiery proServer system.
Fiery System Tools has the following menus:

Command Description

Back up your system Saves a backup of the hard disk drive to a data storage medium, such as a USB drive, an
external hard disk, or a network location. You can also create a backup in a subfolder of the
local hard disk.

View backup history Displays the date and time of created backups.

Restore system from a
previous backup

Deletes all the data on the hard disk drives, and returns the Fiery proServer embedded system
to an earlier state from a backup.

Restore to factory defaults Reinstalls the Fiery proServer embedded system from a hidden partition on the hard disk
drive. This operation causes all system data to be lost.

Restore a backup made on a
previous system

Restores an existing backup to a new embedded Fiery proServer system.

Create system recovery
media

Saves a bootable copy of the system’s recovery partition to a data storage medium, such as a
USB drive, or an external hard disk. You can use a system recovery to return an embedded
Fiery proServer to an earlier state —for example, after the hard disk has been replaced but no
backup is available, or the backup exists as a network fileshare.

Change system language Changes the language of the operating system and keyboard, Fiery XF Control, and Fiery XF.

Create network fileshare
setup file

Allows you to set up a shared network folder with access credentials for backup and restore
purposes.

Set up e-mail notification Allows you to receive an e-mail notification when the installation, backup, or restore is
complete, which can take more than an hour.

Back up Fiery proServer system

1 In the Windows taskbar, start Fiery System Tools.
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2 Click Back up your system.

3 Select one of the following backup destinations:

• USB flash drive

• External HDD

• Network share

• Subfolder of the local hard disk

Note:

To create a backup of Fiery proServer Core, you require a USB flash drive or an external hard drive. The data
storage medium must have a minimum of 16 GB storage space (32 GB is recommended), have no more than one
partition, and be formatted to NTFS.

4 Select Include Fiery job files in backup (optional).
Be aware that job files can be backed up, but not the output files that reside in the Export folder due to their size.

5 If your system backup file will be created on a USB flash drive or an external HDD, plug the device into a USB
port on the Fiery proServer.

6 Click Next.

7 Click Restart.
The backup process is complete when the system returns to Windows.

Restore the Fiery proServer

The Fiery proServer system is restored with all the settings, including system environments, that were current at the
time the backup was created.
Any settings made after the backup was created are lost. The restore procedure may take up to one hour, depending
on the backup medium used and the volume of job data.

1 Make sure that the system backup file is accessible from one of the following locations:

• USB flash drive

• External HDD

• Network share

• Local system

2 If your system backup file is stored on a USB flash drive or an external HDD, plug the device into a USB port on
the Fiery proServer.

3 In the Windows taskbar, start Fiery System Tools.

4 Click Restore system from a previous backup.

5 Select the backup to restore on the replacement system and click Next. .
If you created a backup in a network share, click Search Network. Type the network location and logon
information, and then click OK to log on to the server. Then, select the backup that you want to restore.
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6 Click Continue to confirm that you want to erase all the data on the hard disk drive.

7 Continue to follow the on-screen instructions.
At the end of the procedure, Windows starts automatically. You do not need to reactivate the license if the Fiery
XF software was already licensed before the backup.

Return Fiery proServer to its factory state

You need to return the Fiery proServer to its factory state, for example, if the default password has been changed and
the new password has been misplaced. The Fiery XF software software license and all your client software settings,
including system environments, are deleted from the hard disk drives.
1 In the Windows taskbar, start Fiery System Tools.

2 Click Restore to factory defaults.

3 Click Restart to confirm that you want to erase all the data on the hard disk drive and to start the restore
procedure.
At the end of the procedure, Windows starts automatically. You need to reinstall the license for the Fiery XF
software. For more information, see Managing licenses on page 17.

Reinstalling Fiery proServer Premium system software from DVDs

If necessary, you can reinstall system software from the DVDs, instead of Fiery System Tools.
Before reinstalling system software, you must make a note of your License Activation Code and deactivate the
license. See Managing licenses on page 17.
All Fiery proServers are shipped with a Fiery System Tools icon preinstalled on the taskbar. This tool provides a
method to back up and restore system settings, or to return your system to its factory state. If you have a Fiery
proServer SE or Core, you must use Fiery System Tools, as the hardware does not come with a DVD drive and
installation DVDs. To start Fiery System Tools, double-click the icon on the taskbar, and follow the on-screen
instructions.
The steps described below are for the Fiery proServer Premium, and require you to insert System Software DVD 1.

Note: Reinstalling the Fiery proServer Premium system software can take up to one hour.
.

1 Do one of the following:

• If the Fiery proServer Premium is running, exit Fiery XF. Insert the System Software 1 DVD and reboot the
Fiery proServer Premium.

• If the Fiery proServer Premium is frozen or unresponsive, hold down the power button on the front panel until
the system powers off. Press the power button once to power on the system and immediately insert the System
Software DVD 1 (Fiery XF server).

Wait for the system to boot from the DVD and for Windows to load the installation files. This takes a few
minutes.
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2 When requested, select a language from the drop-down list box.
This is the language used to lead you through the installation procedure.

3 When asked what you want to do, click New Installation.

4 Click Continue to confirm that you want to erase all the data on the hard disk drive.

5 Continue to follow the on-screen instructions. When requested, insert first the System Software DVD 2 (Win 10
OS DVD 1/2), then the System Software DVD 3 (Win 10 OS DVD 2/2), and finally User Software DVD 4 (Fiery
Command WorkStation).
At the end of the procedure, Windows starts automatically. You must now select the system language and
activate the Fiery XF license.

Activating the Fiery XF software license

On first time connection to Fiery XF software, you must activate the license.
Make sure you have your License Activation Code (LAC), which is shipped with your Fiery proServer. The LAC is
required to activate the software. Store your LAC so that it is available for future reference, in case of deactivation.
Select and copy it after or during activation and then paste it into a text document, store that on a network drectory,
or on a USB flash drive.
The Fiery XF software comes pre-installed with Command WorkStation on the Fiery proServer. Different
instructions will be provided, depending on whether the Fiery proServer is connected to the internet or not.

1 Start the Fiery proServer.

2 In the Fiery proServer Configuration window, click Activate software.

3 Select Activate if you have a LAC, and follow the on-screen instructions.

4 Click Migrate if you are upgrading from a legacy dongle-protected Fiery server and follow the on-screen
instructions.
The LAC will be downloaded from within the application during the migration workflow.

You can always check the status of licenses or manage licenses in Server Manager > Server > License/Contract.
To open the license activation browser after first-time setup, open Fiery Server Control from the Windows taskbar
and select Manage Licenses.

Managing licenses

You can activate or deactivate a product or a product option for this Fiery server at any time.
Make sure you have your License Activation Code (LAC) handy. At the time of first activation, be sure to store your
LAC so that it is available for future reference, in case of deactivation. Select and copy it after or during activation
and then paste it into a text document, store that on a network drectory, or on a USB flash drive.

1 In the taskbar: Right-click Fiery Server Control, and click Manage Licenses.
The License Activation window opens.
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2 Do one of the following:

• To activate a product or a product option for this Fiery server: Click Activate.

• To deactivate a product or product option: Click Deactivate.

Note:

You can activate a deactivated license on a different Fiery server. Make a note of the LAC before you deactivate
the license. If you forget, the LAC is also recorded on the History tab of the License Activation window.

3 Follow the on-screen instructions.

4 Restart the Fiery server.

Now watch the video here.
You can display the contents of an activated license, by expanding the license name in the Product/Option column.

Anti-virus software

The Fiery proServer does not come with anti-virus software preinstalled.
In production environments in which files are regularly exchanged with customers, it is strongly recommended that
you install an anti-virus program of your choice. When installing an anti-virus program, make sure that the following
network ports are not blocked as they are needed for specific features of the Fiery XF software.

Port Used for

4108 Epson Spectroproofer

8010, 8013 Bi-directional communication service

8020, 8022, 8030, 8032 Integration and connectivity between Fiery XF server and EFI printers

8051, 8052, 8053, 8054, 8061, 8062, 8063,
8064

Communication between Fiery XF server and APPE processes (up to four
instances)

27000 to 27009, 60000 License management/EFI Cut Server

50005 to 50026 General communication between Fiery XF server and Fiery XF client

20020 to 20021 (UDP only) Fiery XF server discovery

Troubleshooting Fiery proServer

The following sections describe the source of common problems that may occur with the Fiery proServer.
A number of suggestions to resolve these problems are provided.

Fiery proServer User Guide

Introduction

18

http://fiery.efi.com/system102-4


Checking the Fiery proServer configuration

This section describes the quick checks that you can do to make sure that the problem is not caused by an incorrect
Fiery proServer configuration.

Does the Fiery proServer start up normally?

If, during startup, you hear 4 beeps, followed by 3 beeps, followed by 1 beep, followed by 2 beeps, there may be a
problem with the memory. Contact your authorized service/support center.

Is the Fiery Server Control icon green?

The Fiery Server Control icon is located in the Windows taskbar. A green arrow indicates that Fiery Server Control
is running.
If the arrow is red, try the following:.

• You may have not activated the license correctly. A dialog should appear asking you to enter your LAC.

• Verify that no unauthorized software is installed on the Fiery proServer.
Third-party applications are not supported and can cause system problems. Although anti-virus software is
permitted on the Fiery proServer, you should run virus scans only when the Fiery proServer is in Idle mode (not
processing or printing any jobs).

Is the connection to the printer correctly configured?

The connection to the printer may not be correctly configured.
Try the following:

• Use the Fiery XF server to send a test job to the printer.

• Restart the printer.
If the problem persists, you may need to test and service the printer. For more information, see the
documentation that accompanies the printer.

• Verify that the problem is not caused by a particular print job or application.

Try printing a different job or using a different printing application.
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Is the network functioning?

You may have issues with the network, or the Fiery proServer may not be properly connected to the network.
Verify the following:

• The Fiery proServer appears in the list of computers on the network.
If the Fiery proServer does not appear in the list of computers on the network, another device on the network
may have been assigned the same Ethernet hardware address.

• The Fiery proServer DHCP setting matches the DHCP setting of the customer’s network.
If DHCP error messages appear on the monitor, the Fiery proServer may be searching for a non-existent DHCP
server. DHCP is enabled by default on the Fiery proServer, but the customer’s network may not be using DHCP.
In this case, you need to configure a static IP address for the Fiery proServer.
If the problem persists, check the interface connections. For more information, see Checking interface
connections on page 21.

Is the setting for showing hidden files selected?

You must be able to access some files in the Program Data folder for certain troubleshooting purposes.
1 Move the mouse pointer to the lower-left corner of the screen to see the Windows icon.

2 Right-click the Windows icon, and then click Control Panel.

3 Set the Control Panel display to view by small icons.

4 Click File Explorer Options, and then click the View tab.

5 Under Advanced Settings, select Files and Folders > Hidden files and folders, and click Show hidden files, folders,
and drives.

6 Clear Hide extensions for known file types.

7 Click OK to confirm the changes.

Is the JobFolder folder shared?

The JobFolder folder must be shared to allow access to hot folders.
1 On the C:\ drive, right-click the Jobs folder and click Properties.

2 On the Sharing tab, click Advanced Sharing.

3 Select Share this folder, and click Permissions.

4 Select Everyone, and set the permission level to Read and change. Then, click Apply.

5 Click OK to confirm the changes, and close all windows.
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Is the Output folder shared?

The Export directory must be shared so that the printer has access to pull output files from the Fiery proServer.
The procedure below describes how to enable sharing with the Output folder.

1 Right-click the Output folder and click Properties.
Depending on your model of Fiery proServer, the Output folder is located either on the D:\ or E:\ drive.

2 On the Sharing tab, click Advanced Sharing.

3 Select Share this folder, and click Permissions.

4 Select Everyone, and set the permission level to Read and change.

5 Then, click Apply.

6 Click OK to confirm the changes, and close all windows.

Checking interface connections

This section describes the quick checks that you can do to make sure that the problem is not caused by a loose
connection at the back of the Fiery proServer.
Verify the following:

• All components and interface cables to the system are securely plugged into the correct ports on the back of the
Fiery proServer. After verifying the connections, reboot the Fiery proServer.
For an illustration of the correct ports and connections at the back of the Fiery proServer, see Connecting and
starting the Fiery proServer on page 5.

• The power cable is plugged into the power outlet, and the Fiery proServer is powered on.
For more information, see Connecting and starting the Fiery proServer on page 5. If the Fiery proServer does not
start, try replacing the power cable with a new or tested cable.

• The upper LED next to the network port is on or blinking to indicate network activity.
If the upper LED is off, verify that the network cable is properly connected to the correct network port on the
Fiery proServer and to the network device on the customer network. If the problem persists, try replacing the
network cable with a new or tested cable.

Troubleshooting corrupted system software

If verifying the Fiery proServer configuration and connections do not correct the problem, the problem may be
caused by corrupted system software.
To remedy the problem, restore the Fiery proServer system to an earlier state. See Return Fiery proServer to its
factory state on page 16.
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Downloading documentation

You can access and download all Fiery proServer documentation at any time.
The Installation Guide is provided printed in your accessory box and also online. The Quick Start Guide is provided
printed in English in your accessory box and also online. The Quick Start Guide in other languages is provided
online. All other documentation is provided online.
The Fiery proServer documentation set consists of the following:

• Installation Guide describes how to install the Fiery proServer and activate the Fiery XF license.

• Quick Start Guide is a step-by-step guide on how to set up and use the Fiery proServer with your EFI inkjet
printer.

• Upgrade Guide describes how to upgrade the Fiery XF software on your Fiery proServer from a previous version.

• User Guide describes how to keep the Fiery proServer in good working condition after initial installation and
setup.

1 Double-click the Adobe icon on the Fiery proServer desktop to open the Adobe website and download Adobe
Reader.
You need Adobe Reader in order to access the Fiery proServer documentation, which is provided in PDF format.

2 Open the web browser of your choice.

3 To download the Fiery proServer Installation Guide, Quick Start Guide, Upgrade Guide, or User Guide, go to 
help.efi.com.

4 As needed, click the links for your product version and language, and download the latest documentation.

Fiery XF server online help

The Fiery XF server includes a comprehensive help system.

• The application help provides detailed information on how to set up and use each feature of the software. In
Command WorkStation, select Help in the Help menu.
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